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B.Tech  IV-I Semester (IT) 
 

S. 
No. 

Course  
Code 

Subject L T P C 

1. 15A52601 Management Science  3 1 - 3 

2. 15A10701 Internetworking with TCP/IP  3 1 - 3 

3. 15A10702 Scripting Languages 3 1 - 3 

4. 15A05703 Mobile Application Development 3 1 - 3 

5.  
15A05706 
15A05707 
15A05805 

CBCC-II 
a. Machine Learning 
b. Software Project Management 
c. Enabling Technologies for Data Science 
& Analytics: IoT   

3 1 - 3 

6.  
15A10703 
15A10704 
15A05709 

CBCC-III 
a. Human Computer Interaction  
b. Information Retrieval Systems  
c.  Real Time Systems 

3 1 - 3 

7. 15A10705 Scripting Languages Laboratory - - 4 2 

8. 15A05711 Mobile Application Development 
Laboratory 

- - 4 2 

                                                               Total: 18 6 8 22 

6 Theory + 2 Laboratories 
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JAWAHARLAL NEHRU TECHNOLOGICAL UNIVERSITY ANANTAPUR 

B. Tech  IV-I Sem. (IT) 
L T P C 
3 1 0 3 

15A52601 MANAGEMENT SCIENCE 
 
 

Course Objectives: The objective of the course is to equip the student the fundamental 
knowledge of management science and its application for effective management of 
human resource, materials and operation of an organization. It also aims to expose the 
students about the latest and contemporary developments in the field of management. 
 
UNIT –I: Introduction to Management: Concept-Nature and Importance of 
Management, Functions-Evaluation of Scientific Management, Modern management-
Motivation Theories-Leadership Styles-Decision Making Process-Designing 
Organization Structure-Principles and Types of Organization. 
 
UNIT- II: Operations Management: Plant location and Layout, Methods of production, 
Work-Study-Statistical Quality Control through Control Charts, Objectives of Inventory 
Management, Need for Inventory Control-EOQ&ABC Analysis(Simple 
Problems)Marketing Management: 
Meaning, Nature, Functions of Marketing, Marketing Mix, Channels of distribution-
Advertisement and sales promotion-Marketing strategies-Product Life Cycle. 
 
UNIT -III: Human Resource Management (HRM): Significant and Basic functions of 
HRM-Human Resource Planning(HRP), Job evaluation, Recruitment and Selection, 
Placement and Induction-Wage and Salary administration. Employee Training and 
development-Methods-Performance  Appraisal-Employee Grievances-techniques of 
handling Grievances. 
 
UNIT –IV: Strategic Management: Vision, Mission, Goals and Strategy- Corporate   
Planning Process-Environmental Scanning-SWOT analysis-Different Steps in Strateg 
Formulation, Implementation and Evaluation. Project Management: Network Analysis-
PERT, CPM, Identifying Critical Path-Probability-Project Cost Analysis, Project 
Crashing (Simple Problems). 
 
UNIT-V: Contemporary Management Practices: Basic concepts of MIS-Materials 
Requirement Planning(MRP),Just-In-Time(JIT)System, Total Quality 
Management(TQM)-Six Sigma and Capability Maturity Models(CMM) evies, Supply 
Chain Management, Enterprise Resource Planning(ERP),Performance Management, 
Business Process Outsourcing(BPO), Business Process Re-Engineering and Bench 
Marking, Balance Score Card. 
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Course Outcomes: This course enables the student to know the principles and 
applications of management knowledge and exposure to the latest developments in the 
field. This helps to take effective and efficient management decisions on physical and 
human resources of an organization. Beside the knowledge of Management Science 
facilitates for his/her personal and professional development.  
 

TEXT BOOKS: 

1. A.R Aryasri: Management Science, TMH, 2013 

2. Kumar /Rao/Chalill ‗Introduction to Management Science‘ Cengage, Delhi, 2012.  

 

REFERENCE BOOKS: 

1. A.K.Gupta ―Engineering Management‖,S.CHAND, New Delhi, 2016. 

2. Stoner, Freeman, Gilbert, Management, Pearson Education,New Delhi, 2012. 

3. Kotler Philip & Keller Kevin Lane: Marketing Mangement , PHI,2013. 

5. Koontz & Weihrich: Essentials of Management, 6/e, TMH, 2005. 

6. Kanishka Bedi, Production and Operations Management, Oxford University Press, 

2004. 

7. Memoria & S.V.Gauker, Personnel Management, Himalaya, 25/e, 2005 

8. Parnell: Strategic Management, Biztantra, 2003. 

9. L.S.Srinath: PERT/CPM,Affiliated East-West Press, 2005. 
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JAWAHARLAL NEHRU TECHNOLOGICAL UNIVERSITY ANANTAPUR 

B. Tech  IV-I Sem. (IT) 
L T P C 
3 1 0 3 

15A10701 INTERNET WORKING WITH TCP / IP 

 
Course Objectives: 

 To understand the concepts and techniques that have been used to design 
and implement the TCP/IP Internet 

 To understand the issues that are driving the development of new protocols to 
broaden and enhance the operation of the Internet 

 To understand stream control protocol, network management. 

 To study various network protocols.   
 
Course Outcomes: 

 Ability to configure a network. 

 Ability to remotely access other computers.    

 Ability to upload and download files. 
 
Unit 1:  
Stream Control Transmission Protocol (SCTP): 
Introduction, SCTP Services, SCTP Features, Packet Format, An SCTP Association, 
State Transition Diagram, Flow Control, Error Control, Congestion control 
Introduction to the application layer:    
Client server paradigm, Peer to peer paradigm 
 
Unit 2: 
HOST Configuration (DHCP):  Introduction, DHCP operation, Configuration 
Remote Login: Telnet and SSH: Telnet, secure shell  
 
Unit 3: 
File Transfer: FTP and TFTP: FTP, TFTP 
World Wide Web and HTTP: Architecture, web documents, HTTP 
Electronic Mail: SMTP, POP, IMAP, and MIME:  Architecture, User Agent, Message 
Transfer Agent: SMTP, Message Access Agent: POP and IMAP, MIME, Web based 
mail, Email security 
 
Unit 4: 
Network Management: SNMP: Concept, Management components, SMI, MIB, SNMP, 
UDP Ports, Security 
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Multimedia: Introduction, digitizing audio and video, Audio and video compression, 
Streaming stored audio/video, Streaming Live audio/video, Real time interactive 
audio/video, RTP, RTCP, Voice over IP, Quality of service, Integrated services, 
Differentiated services 
 
Unit 5: 
IPv6 Addressing: Introduction, Address space allocation, Global unicast address, Auto 
configuration, Renumbering 
 
IPv6 Protocol: Introduction, Packet format, Transition from IPv4 to IPv6 
ICMPv6: Introduction, Error Messages, Informational Messages, Neighbor- Discovery 
Messages, Group Membership Messages.   
 
TEXT BOOKS: 

1. TCP/IP Protocol Suite, Behrouz A. Forouzan, 4th edition, TMH,2010 
 
REFERENCES  
 1. TCP/IP, Tittel Chappell, Cengage Learning. 
2. TCP/IP Illustrated, Volume,1the Protocols, W. Richard Stevens, G. Gabrani, Pearson. 
3. TCP/IP Application Layer Protocols for Embedded Systems, M.Tim Jones, Networking Series. 
4. Internetworking With TCP/IP Volume 1: Principles Protocols, and Architecture, 5th edition,   
    2006. ISBN 0,13,187671,6. 
5. Internetworking With TCP/IP Volume II: Design, Implementation, and Internals (with D.  
    Stevens), Third edition, 1999. ISBN 0,13,973843,6. 
6. Internetworking With TCP/IP Volume III: Client,Server Programming and Applications,  
    Linux/POSIX Socket Version (with D. Stevens), 2000. 0,13,032071,4. 
7. Internetworking With TCP/IP Volume III: Client,Server Programming and Applications, BSD  
    Socket Version (with D. Stevens), second edition 1996. 0,13,260969,X. 
8. Internetworking With TCP/IP Volume III: Client,Server Programming and Applications,  
    AT&T TLI Version (with D. Stevens), 1994. ISBN 0,13,474230,3. 
9. Internetworking With TCP/IP Volume III: Client,Server Programming and Applications,  
    Window Sockets Version (with D. Stevens), 1997. ISBN 0,13,848714,6. 
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JAWAHARLAL NEHRU TECHNOLOGICAL UNIVERSITY ANANTAPUR 

B. Tech  IV-I Sem. (IT) 
L T P C 
3 1 0 3 

15A10702 SCRIPTING LANGUAGES  

 
 

Course Objectives: 
The primary objective of the course is to learn web programming by designing and 
developing a web based project and also learn basic User Interface Principles.  

 
Course Outcomes: 
At the end of the course, the student should be able to: 

 Ability to build interactive, data-driven sites and solve real time problems 
using PHP 

 Ability to create dynamic web pages using the PHP scripting language and 
MySQL database. 

 Understand the concepts of object-oriented programming as used in Python: 
classes, subclasses, inheritance, and overriding. Understand the basics of 
OO design. 

Unit-1 
Essential PHP: Enter PHP, Getting PHP, Creating your Development Environment, 
Creating and running first PHP page, Mixing HTML and PHP, Printing some Text, Using 
PHP ―here‖ documents, command-line PHP, comments, variables, storing data, 
Interpolating Strings, creating variables and constants and data types. 
Operators and flow controls: PHP‘s Math Operators, working with the assignment 
operator, Increment and decrement values, String operators, Bitwise, Execution 
operator, Operator precedence, If statement, comparison operator, logical operators, 
else, elif, ternary, switch, for, while, do-while loops, foreach, terminating, skipping 
iterations. 
Strings and Arrays: String Functions, Converting to and from Strings, Formatting Text 
Strings, Arrays, Array PHP Functions, Sorting Arrays, handling Multi dimensional 
arrays, splitting and merging arrays. 
 
Unit-2 
Creating Functions: Creating in Functions in PHP, Passing Functions some data, 
Passing Arrays to functions, Passing by reference, default arguments, returning data 
from functions, returning arrays and lists, variable scope in php, accessing global data, 
static variables, conditional functions, nesting functions, creating include files, returning 
errors  from functions. 
Reading data in web Pages: Setting up web pages to communicate with PHP, 
Handling of Text fields, Text areas, Check boxes, Radio buttons, List boxes, Password 
controls, Hidden controls, Image Maps, File Uploads, buttons. 
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PHP browser Handling Power: Using PHP‘s Server Variables, HTTP Headers, User‘s 
browser type, Redirecting browsers with HTTP Headers, Dumping a form‘s data all at 
once, Handling form data with custom arrays, putting all it into the page, performing 
data validation, checking entered data, requiring numbers and text, Persisting user 
data, client side data validation, handling html tags in user input. 
 
Unit-3 
Object Oriented Programming: Creation of class and Objects, setting access to 
Properties and methods, Using constructors to Initialize Objects, using Destructors to 
clean up after objects, Inheritance, Method Overriding, overloading, autoloading classes 
. 
Advanced Object Oriented Programming: Creating Static Methods, static members 
and Inheritance, abstract classes, interfaces, Supporting Object Iteration, Comparing 
Objects, creating class constants, final key word, cloning objects. 
Working with Database: what is database?, Essential sql, creating MySql database, 
creating table, Accessing the database in php, Updating, Inserting, deleting, sorting 
data. 
Sessions, Cookies, and FTP: Setting cookie and reading cookie, setting cookie 
expiration, deleting cookies, Working with FTP, Downloading and Uploading and 
deleting files with FTP, creating and removing directories with FTP, Sending E-mail, 
sending advanced email, adding attachments to the email, sorting data. 
 
Unit-4 
Introduction to PYHON: Getting Started with Python Programming, Detecting and 
correcting Syntax errors. 
Software Development, data types, and Expressions: Software Development 
Process, case study: Income tax calculator, Strings, Assignments, and comments, 
Numeric data types and character sets, Expressions, Using functions and modules, 
Control statements. 
Design with Functions: Functions as abstraction Mechanism, Problem solving with 
top-down design, recursive function, File system, Managing a program‘s namespace, 
Higher Order Functions. 
 
Unit-5 
String and Text Files: Accessing characters and substrings in strings, data encryption, 
strings and number Systems, String Methods, Text Files, Case Study : Text Analysis. 
List and Dictionaries: List, Defining simple Functions, case study: generating 
sentences, dictionaries, case study: nondirective psychology. 
Design with classes: Getting inside objects and classes, case study: Playing the game 
of craps, data modelling examples, Structuring classes with Inheritance and 
Polymorphism. 
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Text Books: 
1. The Complete Reference PHP by Steven Holzner, M H HILL Education, Indian 
Edition, 2008. 
2. Fundamentals of PYTHON By Kenneth A. and Lambert and B.L Juneja, Cengage 
Learning, 2012.   
 
 
Reference Books: 
1. Core Python application and programming by Wesley J.Chun, Pearson, 3rd edition. 
2. Introduction to computing and programming in python by Mark. J. Guzdial and  
    Barbara Ericson, Pearson, 4th edition. 
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JAWAHARLAL NEHRU TECHNOLOGICAL UNIVERSITY ANANTAPUR 

B. Tech  IV-I Sem. (IT) 
L T P C 
3 1 0 3 

15A05703 MOBILE APPLICATION DEVELOPMENT  

 
 

Course Objectives: 

 To understand fundamentals of android operating systems.  

 Illustrate the various components, layouts and views in creating android 
applications  

 To understand fundamentals of android programming.  

 
Course Outcomes:    

 Create data sharing with different applications and sending and intercepting 
SMS.  

 Develop applications using services and publishing android applications.  

 To demonstrate their skills of using Android software development tools 
 

Unit 1: Introduction to Android: 
The Android 4.1 jelly Bean SDK, Understanding the Android Software Stack, installing 
the  Android SDK, Creating Android Virtual Devices, Creating the First Android Project, 
Using the Text view Control, Using the Android Emulator, The Android Debug 
Bridge(ADB), Launching Android Applications on a Handset. 
 
Unit 2: Basic Widgets: 
Understanding the Role of Android Application Components, Understanding the Utility 
of Android API, Overview of the Android Project Files, Understanding Activities, Role of 
the Android Manifest File, Creating the User Interface, Commonly Used Layouts and 
Controls, Event Handling, Displaying Messages Through Toast, Creating and Starting 
an Activity, Using the Edit Text Control, Choosing Options with Checkbox, Choosing 
Mutually Exclusive Items Using Radio Buttons 
 
Unit 3: Building Blocks for Android Application Design: 
Introduction to Layouts, Linear Layout, Relative Layout, Absolute Layout, Using Image 
View, Frame Layout, Table Layout, Grid Layout, Adapting to Screen orientation.  
 
Utilizing Resources and Media Resources, Creating Values Resources, Using 
Drawable Resources, Switching States with Toggle Buttons, Creating an Images 
Switcher Application, Scrolling Through Scroll View, playing Audio, Playing Video, 
Displaying Progress with Progress Bar, Using Assets. 
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Unit 4: Using Selection widgets and Debugging: 
Using List View, Using the Spinner control, Using the GridView Control, Creating an 
Image Gallery Using the ViewPager Control, Using the Debugging Tool: Dalvik Debug 
Monitor Service(DDMS), Debugging Application, Using the Debug Perspective. 
 
Displaying And Fetching Information Using Dialogs and Fragments: What Are 
Dialogs?, Selecting the Date and Time in One Application, Fragments, Creating 
Fragments with java Code, Creating Special Fragments 
 
Unit 5: Building Menus and Storing Data: 
Creating Interface Menus and Action Bars, Menus and Their Types, Creating Menus 
Through XML, Creating Menus Through Coding, Applying a Context Menu to a List 
View, Using the Action Bar, Replacing a Menu with the Action Bar, Creating a Tabbed 
Action Bar, Creating a Drop-Down List Action Bar 
 
Using Databases: 
Using the SQLiteOpenHelperclasss, Accessing Databases with the ADB, Creating a 
Data Entry Form,  
 
Communicating with SMS and Emails: 
Understanding Broadcast Receivers, Using the Notification System, Sending SMS 
Messages with Java Code, Receiving SMS Messages, Sending Email, Working With 
Telephony Manager. 
 
Text Books 
1. Android Programming by B.M Harwani, Pearson Education, 2013.    
 
References Text Books:  

1. Android application Development for Java Programmers, James C Sheusi, 
Cengage Learning  

2. Android In Action by w.Frank Ableson, Robi Sen, Chris King, C. Enrique 
Ortiz., Dreamtech.   

3. Professional Android 4 applications development, Reto Meier, Wiley India, 
2012. 

4. Beginning Android 4 applications development, Wei- Meng Lee, Wiley 
India,2013 
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JAWAHARLAL NEHRU TECHNOLOGICAL UNIVERSITY ANANTAPUR 

B. Tech  IV-I Sem. (IT) 
L T P C 
3 1 0 3 

15A05706       MACHINE LEARNING 
               (CBCC-II) 
 

Course Objectives: 

 To understand the basic theory underlying machine learning. 

 To be able to formulate machine learning problems corresponding to different 
applications. 

 To understand a range of machine learning algorithms along with their strengths 
and weaknesses. 

 To be able to apply machine learning algorithms to solve problems of moderate 
complexity. 

 

Course Outcomes: 

 Ability to understand what is learning and why it is essential to the design of 
intelligent machines. 

 Ability to design and implement various machine learning algorithms in a wide 
range of real-world applications. 

 Acquire knowledge  deep learning and be able to implement deep learning 
models for language, vision, speech, decision making, and more 

Unit I: 
What is Machine Learning?, Examples of machine learning applications, supervised 
Learning: learning a class from examples, Vapnik- Chervonenkis dimension, probably 
approximately correct learning, noise, learning multiple classes, regression, model 
selection and generalization, dimensions of a supervised machine learning algorithm. 
Decision Tree Learning:  Introduction,   Decisions Tree representation, Appropriate 
problems for decision tree learning, the basic decision tree learning algorithm, 
Hypothesis space search in decision tree learning, Inductive bias in decision tree 
learning, issues in decision tree learning, Artificial Neural Networks: Introduction, Neural 
Network Representation – Problems – Perceptrons – Multilayer Networks and Back 
Propagation Algorithm, Remarks on the BACKPROPGRATION Algorithm, An 
illustrative Example: Face Recognition, Advanced Topics in Artificial Neural Networks. 
 
Unit 2:     
Evaluating Hypotheses: Motivation, Estimating hypothesis accuracy, basics of sampling 
theory, a general approach for deriving confidence intervals, differences in error of two 
hypothesis, comparing learning algorithms, Bayesian Learning: Introduction, Bayes 
Theorem,   Bayes Theorem and Concept Learning, Maximum Likelihood and least 
squared error hypothesis, Maximum Likelihood hypothesis for predicting probabilities,   
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Minimum Description Length Principle, Bayes Optimal Classifier,  Gibbs Algorithm , 
Naïve Bayes Classifier , Bayesian Belief Network,  EM Algorithm 
 
Unit 3:  
Dimensionality Reduction:  Introduction, Subset selection, principle component 
analysis, feature embedding, factor analysis, singular value decomposition and matrix 
factorization, multidimensional scaling, linear discriminant analysis, canonical 
correlation analysis, Isomap, Locally linear embedding, laplacian eigenmaps, 
Clustering: Introduction, Mixture densities, K- Means clustering, Expectations- 
Maximization  algorithm, Mixture of latent variable models, supervised learning after 
clustering, spectral clustering, Hierarchal clustering, Choosing the number of clusters, 
Nonparametric Methods: Introduction, Non Parametric density estimation, 
generalization to multivariate data, nonparametric classification, condensed nearest 
neighbor, Distance based classification, outlier detection, Nonparametric regression: 
smoothing models, how to choose the smoothing parameter 
 

Unit 4: 
Linear Discrimination: Introduction, Generalizing the linear model, geometry of the 
linear discrimination, pair wise separation, parametric discrimination revisited, gradient 
descent, logistic discrimination, discrimination by regression, learning to rank, Multilayer 
Perceptrons: Introduction, the perceptron, training a perceptron, learning Boolean 
functions, multilayer perceptrons, MLP as a universal approximator, Back propagation 
algorithm, Training procedures, Tuning the network size, Bayesian view of learning, 
dimensionality reduction, learning time, deep learning 
 

Unit 5:               
Kernel Machines: Introduction, Optimal separating hyperplane, the non separable case:  
Soft Margin Hyperplane, ν-SVM, kernel Trick, Vectorial  kernels, defining kernels, 
multiple kernel learning, multicast kernel machines, kernel machines for regression, 
kernel machines for ranking, one-class kernel machines,  large margin nearest neighbor 
classifier,  kernel dimensionality reduction, Graphical models: Introduction, Canonical 
cases for conditional independence, generative models, d separation, belief 
propagation, undirected Graphs: Markov Random files, Learning the structure of a 
graphical model, influence diagrams.      
 
Text Books:  
1) Machine Learning by Tom M. Mitchell, Mc Graw Hill Education, Indian Edition, 2016.   
2) Introduction to Machine learning, Ethem Alpaydin, PHI, 3rd Edition, 2014  
 
References Books:  

1) Machine Learning: An Algorithmic Perspective, Stephen Marsland, Taylor & Francis,   

    CRC Press Book  
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JAWAHARLAL NEHRU TECHNOLOGICAL UNIVERSITY ANANTAPUR 

B. Tech  IV-I Sem. (IT) 
L T P C 
3 1 0 3 

                       15A05707 SOFTWARE PROJECT MANAGEMENT 
                      (CBCC-II) 
 

Course Objectives: 
 

The main goal of software development projects is to create a software system with a 
predetermined functionality and quality in a given time frame and with given costs. For 
achieving this goal, models are required for determining target values and for 
continuously controlling these values. This course focuses on principles, techniques, 
methods & tools for model-based management of software projects, assurance of 
product quality and process adherence (quality assurance), as well as experience-
based creation & improvement of models (process management). The goals of the 
course can be characterized as follows: 
 

 Understanding the specific roles within a software organization as related to 
project and process management 

 Describe the principles, techniques, methods & tools for model-based 
management of software projects, assurance of product quality and process 
adherence (quality assurance), as well as experience-based creation & 
improvement of models (process management). 

 Understanding the basic infrastructure competences (e.g., process modeling 
and measurement) 

 Understanding the basic steps of project planning, project management, 
quality assurance, and process management and their relationships 
 

Course  Outcomes: 

 Describe and determine the purpose and importance of project management 
from the perspectives of planning, tracking and completion of project. 

 Compare and differentiate organization structures and project structures 

 Implement a project to manage project schedule, expenses and resources 
with the application of suitable project management tools 

 

UNIT I 
Conventional Software Management: The waterfall model, conventional software 
Management performance. Evolution of Software Economics: Software Economics, 
pragmatic software cost estimation 
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UNIT II 
Improving Software Economics: Reducing Software product size, improving software 
processes, improving team effectiveness, improving automation, Achieving required 
quality, peer inspections. 
The old way and the new: The principles of conventional software engineering, 
principles of modern software management, transitioning to an iterative process 
 
UNIT III 
Life cycle phases: Engineering and production stages, inception, Elaboration, 
construction, transition phases. 
Artifacts of the process: The artifact sets, Management artifacts, Engineering 
artifacts, programmatic artifacts. Model based software architectures: A Management 
perspective and technical perspective. 
UNIT IV 
Work Flows of the process: Software process workflows, Inter Trans workflows. 
Checkpoints of the Process: Major Mile Stones, Minor Milestones, Periodic status 
assessments. Iterative Process Planning: Work breakdown structures, planning 
guidelines, cost and schedule estimating, Interaction planning process, Pragmatic 
planning. 
Project Organizations and Responsibilities: Line-of-Business Organizations, Project 
Organizations, evolution of Organizations. 
Process Automation: Automation Building Blocks, The Project Environment 
 
UNIT V 
Project Control and Process instrumentation: The server care Metrics, Management 
indicators, quality indicators, life cycle expectations pragmatic Software Metrics, Metrics 
automation. Tailoring the Process: Process discriminates, Example. 
 
Future Software Project Management: Modern Project Profiles Next generation 
Software economics, modern Process transitions. 
 
Case Study: The Command Center Processing and Display System-Replacement 
(CCPDS-R) 
 
Text Books: 

1. Software Project Management, Walker Royce, Pearson Education.  

2. Software Project Management, Bob Hughes & Mike Cotterell, fourth edition,Tata Mc-

Graw Hill 
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Reference Books : 

1. Applied Software Project Management, Andrew Stellman & Jennifer Greene, 

O‟Reilly, 2006 

2. Head First PMP, Jennifer Greene & Andrew Stellman, O‟Reilly,2007 

3. Software Engineering Project Managent, Richard H. Thayer & Edward Yourdon, 

second edition,Wiley India, 2004. 

4. Agile Project Management, Jim Highsmith, Pearson education, 2004 

5. The art of Project management, Scott Berkun, O‟Reilly, 2005. 

6. Software Project Management in Practice, Pankaj Jalote, Pearson Education,2002 
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JAWAHARLAL NEHRU TECHNOLOGICAL UNIVERSITY ANANTAPUR 

B. Tech  IV-I Sem. (IT) 
L T P C 
3 1 0 3 

15A05805 ENABLING TECHNOLOGIES FOR DATA  SCIENCE &  ANALYTICS: IoT 

(CBCC-II) 
 

Course objectives: 

 Students will be explored to the interconnection and integration of the 
physical world and the cyber space. They are also able to design & develop 
IoT Devices.  

 
Course Outcomes: 

 Able to understand the application areas of IoT 

 Able to realize the revolution of Internet in Mobile Devices, Cloud & Sensor 
Networks  

 Able to understand building blocks of Internet of Things and characteristics. 
 
UNIT I: Introduction to Internet of Things 
Introduction, Physical Design of IoT, Logical Design of IoT, IoT Enabling Technologies. 
Domain Specific IoTs 
Introduction, Home Automation, cities, Environment, Retail, Agriculture, Industry, Health 
& Lifestyle. 
 
UNIT II: 
 IoT and M2M 
Introduction, M2M, Difference between IoT and M2M, SDN and NFV for IoT. 
IoT System Management with NETCONF-YANG 
 Need for IoT Systems Management, Simple Network Management Protocol (SNMP), 
Network Operator requirements, NETCONF, YANG, IoT System Management with 
NETCONF-YANG. 
 
UNIT III: Developing Internet of Things 
Introduction, IoT Design Methodology, Case Study on IoT System for Weather 
Monitoring. 
Case Studies Illustrating IoT Design: 
Introduction, Home Automation, Cities, Environment, Agriculture, Productivity 
Applications. 
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UNIT IV 
Advanced Topics: 
Introduction, Apache Hadoop, Using Hadoop Map Reduce for Batch Data Analysis. 
 
IEEE 802.15.4: 
The IEEE 802 committee family of protocols, The physical layer, The Media Access 
control layer, Uses of 802.15.4, The Future of 802.15.4: 802.15.4e and 802.15.4g.   
 
UNIT V: 
ZigBee: 
Development of the standard, ZigBee Architecture, Association, The ZigBee network 
layer, The ZigBee APS Layer, The ZigBee Devices Object (ZDO) and the ZigBee 
Device Profile (ZDP), Zigbee Security, The ZigBee Cluster Library (ZCL), ZigBee 
Applications profiles, The ZigBee Gateway Specifications for network devices.      
 
 
TEXT BOOKS: 
1. Internet of Things a Hands-on Approach by Arshdeep Bahga and Vijay Madisetti. 
University Press.  
2. The Internet of Things key applications and protocols by Oliver Hersent, David 
Boswarthick and Omar elloumi, Wiley Student Edition. 

 
REFFERENCE BOOOKS:  
1. Internet of Things: Architecture, Design Principles and Applications by Raj Kamal 
MCGraw Hill Edition.   
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JAWAHARLAL NEHRU TECHNOLOGICAL UNIVERSITY ANANTAPUR 

B. Tech  IV-I Sem. (IT) 
L T P C 
3 1 0 3 

15A10703 HUMAN COMPUTER INTERACTION 
               (CBCC – III) 
 

Course Objectives: 
 

 Gain an overview of Human-Computer Interaction (HCI), with an understanding 
of user interface design in general, and alternatives to traditional "keyboard 
and mouse" computing 

 Become familiar with the vocabulary associated with sensory and cognitive 
systems as relevant to task performance by humans 

 Be able to apply models from cognitive psychology to predicting user 
performance in various human-computer interaction tasks and recognize the 
limits of human performance as they apply to computer operation 

 Be familiar with a variety of both conventional and non-traditional user interface 
paradigms 

 
Course Outcomes: 

 Find innovative ways of interacting with computers 

 Help the disabled by designing non-traditional ways of interacting 

 Use cognitive psychology in the design of devices for interaction 

UNIT- I                                                       

Introduction: Importance of user Interface – definition, importance of good design, 
Benefits of good design, A brief history of Screen design. 
The graphical user interface – popularity of graphics, the concept of direct 
manipulation, graphical system, Characteristics 
Web user Interface - popularity, characteristics- Principles of user interface. 
 
UNIT- II 
Design process – Understanding how people interact with computers, importance of 
human characteristics human consideration, Human interaction speeds, understanding 
business functions. 
Screen Designing: Design goals – Screen meaning and purpose, organizing screen 
elements, ordering of screen data and content – screen navigation and flow – Visually 
pleasing composition – amount of information – focus and emphasis – presentation  
information simply and meaningfully – information retrieval on web – statistical graphics 
– Technological consideration in interface design. 
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UNIT- III 
System menus: Structures of Menus, Functions of Menus, Content of Menus, Kinds of 
Graphical menus 
Windows: Window characteristics, Components of a window, Window presentation 
styles, Types of windows, Windom management 
 
UNIT- IV 
Controls: Characteristics of device based controls, Selecting the proper device based 
controls, Operable controls, Text Entry/Read-only controls, Selection controls, 
Combination Entry/selection controls, Selecting the proper controls. 
 
UNIT- V 
Graphics: Icons, Multimedia, Color-what is it, Color uses, Color and Human vision, 
Choosing colors 
Testing: The purpose and importance of usability testing, Scope of testing, Prototypes, 
Kinds of Tests, Developing and conducting the test. 
 
Text books: 

1. ―The essential guide to user interface design‖, Wilbert O Galitz,, Wiley, 2nd 
edition, 2013.  

 
References: 

1. ―Designing the user interface‖, 3rd Edition Ben Shneidermann, Pearson 
Education  Asia. 

2. ―Human –Computer Interaction‖, D.R.Olsen, Cengage Learning. 
3. ―Human – Computer Interaction‖,  I.Scott Mackenzie, Elsevier Publishers. 
4. ―Interaction Design‖, Prece, Rogers, Sharps, Wiley Dreamtech. 
5. ―User Interface Design‖, Soren Lauesen , Pearson Education. 
6. ―Human –Computer Interaction‖, Smith - Atakan, Cengage Learning. 
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JAWAHARLAL NEHRU TECHNOLOGICAL UNIVERSITY ANANTAPUR 

B. Tech  IV-I Sem. (IT) 
L T P C 
3 1 0 3 

15A10704 INFORMATION RETRIEVAL SYSTEMS 
              (CBCC-III) 
 

Course Objectives: 

 To learn the different models for information storage and retrieval 

 To learn about the various retrieval utilities 

 To understand indexing and querying in information retrieval systems 

 To expose the students to the notions of structured and semi structured data 

 To learn about web search 

 

Course  Outcomes: 

At the end of the course students will be assessed to determine whether they are able 

to 

 store and retrieve textual documents using appropriate models 

 use the various retrieval utilities for improving search 

 do indexing and compressing documents to improve space and time 
efficiency 

 formulate SQL like queries for unstructured data 

 

UNIT I 

Introduction to Information Retrieval 

Retrieval Strategies: Vector space model, Probabilistic retrieval strategies: Simple 

term weights, Non binary independence model, Language Models 

UNIT II 

Retrieval Utilities: Relevance feedback, Clustering, N-grams, Regression analysis, 

Thesauri. 

UNIT III 

Retrieval Utilities: Semantic networks, Parsing. 

Cross-Language Information Retrieval: Introduction, Crossing the language barrier. 

UNIT IV 

Efficiency: Inverted index, Query processing, Signature files, Duplicate document 

detection 

UNIT V 

Integrating Structured Data and Text: A Historical progression, Information retrieval 

as a relational application, Semi-structured search using a relational schema. 
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Distributed Information Retrieval: A Theoretical model of distribted retrieval, Web 

search. 

 

Text Books : 

1. Information Retrieval – Algorithms and Heuristics, David A. Grossman, Ophir Frieder, 2nd 

Edition, 2012, Springer, (Distributed by Universities Press) 

 

Reference Books : 

1. Modern Information Retrieval Systems, Yates, Pearson Education 

2. Information Storage and Retrieval Systems, Gerald J Kowalski, Mark T Maybury, Springer, 

2000 

3. Mining the Web : Discovering Knowledge from Hypertext Data, Soumen 

Chakrabart i Morgan-Kaufmann Publishers, 2002 

4. An Introduction to Information Retrieval, Christopher D. Manning, Prabhakar Raghavan, 

Hinrich Schütze, , Cambridge University Press, Cambridge, England, 2009 
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JAWAHARLAL NEHRU TECHNOLOGICAL UNIVERSITY ANANTAPUR 

B. Tech  IV-I Sem. (IT) 
L T P C 
3 1 0 3 

                       15A05709  REAL TIME SYSTEMS 
          (CBCC-III) 
 

Course Objectives: 

 Acquire skills necessary to design and develop embedded applications by 
means of real-time operating systems 

 Understand embedded real-time operating systems 
 

Course Outcomes: 

 Characterize real-time systems and describe their functions  

 Analyze, design and implement a real-time system  

 Apply formal methods to the analysis and design of real-time systems  

 Apply formal methods for scheduling real-time systems  

 Characterize and describe reliability and fault tolerance issues and approaches. 

 
Unit-1 
Typical Real time Applications: Digital control, High-level control, Signal processing, 
other Real-time Applications. 
Hard versus Soft Real-Time Systems: Jobs and processors, Release time, dead lines 
and Timing constraints, Hard and soft timing constraints, Hard Real time systems, Soft 
Real-time Systems. 
A Reference Model of Real Time Systems: Processors and resources, Temporal 
parameters of Real time workload, periodic task model, precedence constraints and 
data dependency, Functional parameter, Resource Parameters of Jobs and Parameters 
of Resources, Scheduling Hierarchy. 
Commonly used Approaches to real time Scheduling: Clock-Driven Approach, 
Weighted Round-Robin Approach, Priority driven Approach, Dynamic vs Static 
Systems, Effective release time and deadlines, Optimality of the EDF and LST 
algorithms, Nonoptimality of the EDF and LST algorithms, Challenges in validating 
timing constraints in priority driven System, Off line vs On line scheduling, summary. 
 
 Unit-2 
Clock-Driven Scheduling: Notations and Assumptions, static, Timer-Driven scheduler, 
General Structure of the Cyclic Scheduler, Improving the average response time of 
Aperiodic Jobs, Scheduling sporadic Jobs, Practical considerations and generalizations, 
Algorithm for generating Static Schedules, Pros and cons of Clock-driven scheduling, 
summary. 
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Unit-3 
Priority-Driven Scheduling of periodic Tasks : Static Assumption, Fixed-priority vs 
Dynamic-priority Algorithms, Maximum Schedulable Utilization, Optimality of the RM 
and DM Algorithms, A Schedulability test for Fixed-priority tasks with Short Response 
time, A Schedulability test for Fixed-priority tasks with arbitrary Response time, 
Sufficient Schedulability conditions for the RM and DM Algorithms, summary. 
 
Unit-4 
Scheduling Aperiodic and Sporadic Jobs in Priority Driven Systems: Assumptions 
and approaches, Diferrable servers, Sporadic Servers, Constant utilization, total 
bandwidth and weighted fair –Queueing servers, Slack stealing in Dead-line Driven 
System, Stack stealing in Fixed-priority systems, Scheduling of sporadic jobs, Real-time 
performance for jobs with soft timing constraints, A two-level scheme for Integrated 
scheduling. 
 
Unit-5 
Resources and Resource access control: Assumptions on Resources and their 
usage, Effects of Resource contention and resource access control, Non Preemptive 
critical section, Basic Priority inheritance protocol, Basic Priority ceiling protocol, Stack 
–based, Priority ceiling protocol, Use of priority ceiling protocol in Dynamic  priority 
systems, pre-emption ceiling protocol, Controlling accesses to Multiple unit Resources, 
Controlling concurrent accesses to data objects. 
 
Multiprocessor Scheduling, Resource access control, and Synchronization: 
Model of Multiprocessor and Distributed Systems, Task assignment, Multiprocessor 
Priority ceiling protocol, Elements of Scheduling Algorithms for End-to-End Periodic 
Tasks, Schedulability of Fixed-priority End-to-End periodic Tasks, End to End tasks in 
heterogeneous Systems, Predictability and validation of Dynamic Multiprocessor 
Systems, Summary. 
 
Text Book:  
       1.    ―Real-Time Systems‖ by Jane W.S Liu, Pearson Edition, 2006. 
 
Reference Text Book:   

1. Real-Time Systems: Scheduling, Analysis, and Verification, Cheng, A. M. K.:  
Wiley, 2002. 

2. Z.: Scheduling in Real-Time Systems, by Cottet, F., Delacroix, J., Kaiser, C., 
Mammeri John Wiley & Sons, 2002. 
Real-Time Systems, C. M., Shin, K. G. McGraw-Hill, Krishna 1997. 
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JAWAHARLAL NEHRU TECHNOLOGICAL UNIVERSITY ANANTAPUR 

B. Tech  IV-I Sem. (IT) 
L T P C 
0 0 4 2 

15A10705 SCRIPTING LANGUAGES LABORATORY 

 
Course Objectives: 
The primary objective of the course is to learn web programming by designing and 
developing a web based project and also learn basic User Interface Principles.  

 

Course Outcomes: 

At the end of the course, the student should be able to: 

 

 Ability to build interactive, data-driven sites and solve real time problems 
using PHP 

 Ability to create dynamic web pages using the PHP scripting language and 
MySQL database. 

 Understand the concepts of object-oriented programming as used in Python: 
classes, subclasses, inheritance, and overriding. Understand the basics of 
OO design. 

Scripting Languages  

 

1. Installation of IIS/WAMP/XAMPP/LAMP web server and configure apache 
modules and php extensions. 

2. Write a program to illustrate the use of  
a) Conditional statements 
b) Looping statements 
c) Array functions 
In php. 

3. Write a program to generate Fibonacci series for a given number using 
Object-oriented PHP. 

4. Design a HTML form for Registration process (which includes various input 
types) and validate all the fields using JavaScript. 

5. Submitting the registration form using following technologies : 
a) HTML form submit 
b) AJAX 
c) JQuery 

 

6. Write a program to illustrate cross-site scripting attack and sanitizing & 
filtering user input. 
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7. Connect to MySQL database using the following concepts in php 
a) MySQLi functions 
b) Prepared statements 
c) PDO 

8. Create a login application with the help of following techniques. 
a) Sessions 
b) Cookies 

9. Write a program to implement full-text search interface using PHP and 
MySQL. 

10. Write a python program for Income Tax Calculator. 
11. Write a python program to illustrate Text Analysis. 
12. Write a python program to simulate craps game. 
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                 15A05711 MOBILE APPLICATION DEVELOPMENT LABORATORY  

 
Course Objectives: 

 To understand fundamentals of android operating systems.  

 Illustrate the various components, layouts and views in creating android 
applications  

 To understand fundamentals of android programming.  
 

Course Out comes:    

 Create data sharing with different applications and sending and intercepting 
SMS.  

 Develop applications using services and publishing android applications.  

 To demonstrate their skills of using Android software development tools 
 

1. Setting Up the Development Environment 
        1.1 Download/Install the SDK 
For in-depth instructions, visit Android Installation Documentation. Otherwise perform 
the following steps. 

 Go to http://developer.android.com/sdk/index.html. 

 Unpack to a convenient location - Remember the full path to this location, 
we will refer to it as <android_sdk_dir> for the rest of the lab. 

 <android_sdk_dir> would then be 
/home/<username>/android_dir. 

 Add the path to the <android_sdk_dir>/tools directory to your system PATH 

 Windows: 
1. Right-click My Computer. 
2. Click Properties. 
3. Click Advanced tab. 
4. Click Environment Variables button. 
5. Double Click Path under System Variables. 
6. Add ; <android_sdk_dir>/tools;<android_sdk_dir>/platform-tools 

to the end of the Variable Values text field. 

 Navigate to your <android_sdk_dir>/tools directory and type android. 
Add the appropriate components.  See step 4 
in http://developer.android.com/sdk/installing.html. 

 Test your installation by running adb from the command line.  If you did 
everything right, you should get a long list of help instructions. 

1.2 Download/Install the Eclipse Plugin 
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 It is recommended that you use Eclipse 3.4 or later 

 Lab Machines - Fedora Eclipse based on 3.4.2 
The version of Eclipse used by the lab machines is missing a vital 
component and requires adding an additional Eclipse plugin in order to 
use the Android plugin: 
1. Click the menu Help -> Software Updates. 
2. Click the tab Available Software -> Add Site button. 
3. Enter http:// download.eclipse.org/releases/ganymede into 

the Location field. 
4. Click OK button. 
5. Enter WST Common UI into the search/text box at the top of the 

window (give it a second, it tries to search as you type and its kind of 
slow). 

6. Click the checkbox next to WST Common UI. 
7. Click the Install button. 
8. Click the Next button. 
9. Accept the terms, click Finish. 
10. Restart Eclipse. 
11. Follow the steps in the next bullet 3.4 Ganymede. 

 

 Eclipse 3.4 Ganymede: 
1. Click the menu Help -> Software Updates. 
2. Click Available Software tab -> Add Site button. 
3. Enter https://dl-ssl.google.com/andriod/eclipse into the "Location" field. 
4. Click OK button. 
5. Click the checkbox next to Developer Tools. 
6. Click the Install button. 
7. Click the Next button. 
8. Accept the terms, click Finish. 
9. Restart Eclipse. 

o Eclipse 3.5 Galileo: 
1. Click Help -> Install New Software . 
2. Click Add... button. 
3. Enter a name for the site into the Name field. 
4. Enter htpps://dl-ssl/google.com/android/eclipse/ into the Location field. 
5. Click OK button. 
6. Click the checkbox next to Developer Tools. 
7. Click the Next button. 
8. Accept the terms, click Finish. 
9. Restart Eclipse. 

 

 Point Eclipse to <android_sdk_dir>: 
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1. Click the menu Window -> Preferences. 
2. Click Android from the Hierarchy view on the left hand side. 
3. Enter <android_sdk_dir> into the SDK Location field. 
4. Click the Apply button. 
5. Click the OK button. 

 
1.3 Download/Install the SDK Platform Components 
 
At the time of writing this lab there are are eight different versions of the Android 
Platform available, ranging from 1.1 to 2.2. It is best practice to develop for the oldest 
platform available that still provides the functionality you need. This way you can be 
assured that your application will be supported by as many devices as possible. 
However, you will still want to download newer versions of the platforms so that you can 
test your applications against these as well. Due to the size of each platform component 
you will only be required to download and develop on one platform for the whole class. 
We will target the highest platform that the G1 phones support, Android 1.6 (API 
4).  Before we can begin developing we must download and install this platform: 

 Select the menu Window -> "Android SDK and AVD Manager", or click on the 
black phone shaped icon in the toolbar. 

 Select Available Packages on the left hand side. 

 Expand the Google Android site in the "Site, Packages, and Archives" Tree. 

 Check the following items: 

 SDK Plaform Android 1.6, API 4 Revision 3 

 Google APIs by Google Inc., Android API 4, Revision 2 

 NOTE: Those of you developing on Lab Machines should follow 
these instructions: http://sites.google.com/site/androidhowto/how-to-
1/set-up-the-sdk-on-lab-machines-linux. 

 Click Install Selected. 

 Accept the Terms for all packages and click Install Accepted. 
We're now ready to develop our application. 
2. Create "Hello World" Application 

2.1 Create a new Android Project  
2.2 Run "Hello World" on the Emulator 
2.3  On a Physical Device 
2.4 Greeting the User 

3. Create Application by Using Widgets 
3.1 Creating the Application by using the Activity class 

(i) onCreate() 
(ii) onStart() 
(iii) onResume() 
(iv) onPause() 
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(v) onStop() 
(vi) onDestroy() 
(vii) onRestart()  

3.2 Creating the Application by using Text Edit control. 
3.3 Creating the Application Choosing Options  

(i) CheckBox 
(ii) RadioButton 
(iii) RadioGroup 
(iv) Spinner 

4. Create Application by Using Building Blocks for Android Application Design 
 4.1 Design the Application by using  

(i) Linear Layout 
(ii) Relative Layout 
(iii) Absolute Layout 

 4.2 Create the Application to play the Audio and Video clips. 
5. Create Application by Using Building Menus and Storing Data 
 5.1 Design the Application for Menus and Action Bar 

 5.2 Design the application to display the Drop-Down List Action Bar 
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